LIMITED WARRANTY ON MEDIA AND REPLACEMENT

If you discover physical defects in the manuals distributed with an Apple product or in the media on which a software product is distributed, Apple will replace the media or manuals at no charge to you, provided you return the item to be replaced with proof of purchase to Apple or an authorized Apple dealer during the 90-day period after you purchased the software. In addition, Apple will replace damaged software media and manuals for as long as the software product is included in Apple's Media Exchange Program. While not an upgrade or update method, this program offers additional protection for up to two years or more from the date of your original purchase. See your authorized Apple dealer for program coverage and details. In some countries the replacement period may be different; check with your authorized Apple dealer.

ALL IMPLIED WARRANTIES ON THE MEDIA AND MANUALS, INCLUDING IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE OF THE ORIGINAL RETAIL PURCHASE OF THIS PRODUCT.

Even though Apple has tested the software and reviewed the documentation, Apple makes no warranty or representation, either express or implied, with respect to software, its quality, performance, merchantability, or fitness for a particular purpose. As a result, this software is sold "as is," and you the purchaser are assuming the entire risk as to its quality and performance.

IN NO EVENT WILL APPLE BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM ANY DEFECT IN THE SOFTWARE OR ITS DOCUMENTATION, even if advised of the possibility of such damages. In particular, Apple shall have no liability for any programs or data stored in or used with Apple products, including the costs of recovering such programs or data.

THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHERS, ORAL OR WRITTEN, EXPRESS OR IMPLIED. No Apple dealer, agent, or employee is authorized to make any modification, extension, or addition to this warranty.

Some states do not allow the exclusion or limitation of implied warranties or liability for incidental or consequential damages, so the above limitation or exclusion may not apply to you. This warranty gives you specific legal rights, and you may also have other rights which vary from state to state.
Includes instructions for the Program Launcher, DeskTop, System Utilities, and the Namer and Chooser
Preface

About the system disk ix

Cast of Utilities ix

Customizing the System Disk xi

Chapter 1

Using the Program Launcher 1

The Program Launcher 2
   Starting an application 2
   Opening a subdirectory 3
   Opening another disk 3
   Ins and outs 3
   Alternative Launcher commands 4

Chapter 2

The DeskTop 5

Using the DeskTop 6
Using the mouse 7
   Clicking 7
   Selecting 8
      Selecting multiple icons 8
   Dragging 8
   Pulling down menus 9
   Choosing menu commands 9
Working with windows 10
   Changing the size of a window 11
   Moving a window 11
   Activating a window 11
   Changing the view through a window 11
   Closing a window 12
DeskTop Fundamentals 12
Add an entry 23
Edit an entry 24
Delete an entry 24
Run an entry 24
The keyboard and the DeskTop 25
Selecting icons with keystrokes 25
Choosing menu commands with keystrokes 25
Controlling windows with keystrokes 25

Chapter 3  System Utilities 27

General instructions 28
Volumes, files, and subdirectories 29
Slot and drive 29
ProDOS pathname 30
Using System Utilities 30
Starting up 30
Selecting from the menu 31
Selecting the location of disks or files 31
Changing slot and drive 32
Entering a ProDOS pathname 33
Selecting files 33
Naming disks and files 34
Rules for naming disks and files 34
Tips for naming disks and files 34
Editing names 35
Stopping 35
Functions of System Utilities 36
Catalog a disk 36
List Volumes 36
Duplicate a Disk 36
Format a Disk 37
Other Options 37
Verify That a Disk Is Readable 38
Copy Files 38
Delete Files 38
Rename Files 39
Lock/Unlock Files 39
Create Subdirectory (ProDOS only) 39
Set Prefix (ProDOS only) 40
Rename Volumes (ProDOS only) 40
That's it 41
Chapter 4  AppleTalk Network Utilities 43

About network utilities 44
Preliminaries 45
Using the Namer 46
Using the Chooser 47
Preparing applications for network printing 48
  AppleWorks meets AppleTalk 48
Figures and tables

Chapter 1  Using the Program Launcher 1
Figure 1-1  Program Launcher screen 2
Table 1-1  Keyboard equivalent 4

Chapter 2  The DeskTop 5
Figure 2-1  The computer desktop 7
Figure 2-2  A menu 9
Figure 2-3  Contents of a disk 10
Table 2-1  Keyboard equivalents for menu commands 26

Chapter 3  System Utilities 27
Table 3-1  Slot and drive 30
Figure 3-1  System Utilities main menu 31
Figure 3-2  Where is your disk? 32
Figure 3-3  Slot and drive 33

Chapter 4  AppleTalk Network Utilities 43
Figure 4-1  Plug in AppleTalk cable 45
Figure 4-2  Set up Control Panel 45
Figure 4-3  Namer 46
Figure 4-4  Chooser 47
About the System Disk

As you use your computer, you'll be storing large quantities of information on disks. Before you know it, you could have shoe boxes full of disks and no idea where to find the information you want.

That's where the *Apple® IIgs™ System Disk* comes in. With the utilities on the System Disk, you'll not only be able to find out what's on your various disks, but you'll be able to organize that information quickly and easily. You can delete the information you don't need anymore, copy related information onto the same disk, give documents more meaningful names so it will be easier to figure out what information they contain, and generally bring order to your disk storage system.

There are also utilities on the System Disk that let you start and switch quickly between applications and that let you print to a LaserWriter® or other printer over an AppleTalk® network.

---

**Important**

Read this book after you've read the *Apple IIgs Owner's Guide*.

---

**Cast of utilities**

Here's a list of the utilities on the System Disk along with brief descriptions of what they can do.
An icon is a picture that represents something—in this case, a disk or a file.

An operating system is a program on every application disk that controls the way information is loaded from disks into memory and how information is saved from memory onto disks. See the Apple II GS Owner's Guide for more on Apple II operating systems.

Applications designed to take advantage of special Apple II GS features (such as its 16-bit microprocessor) use ProDOS16, while applications designed to run on the 8-bit Apple II Plus, Apple IIe, and Apple IIC use ProDOS8. If an application is simply labeled “ProDOS,” it’s probably ProDOS8.

- **Program Launcher:** The Program Launcher is the first program you see when you start up the System Disk. It displays a list of all the files on a disk and lets you start an application by pointing and clicking with the mouse or by using keyboard commands.

- **DeskTop:** Like the Program Launcher, the DeskTop is a mouse-based application that displays the contents of a disk and lets you start applications with a click of the mouse or by using keyboard commands. You can also use the DeskTop to copy, delete, rename, move, and otherwise rearrange the information on ProDOS® disks by manipulating icons as you do on a Macintosh™ computer.

- **System Utilities:** Like the DeskTop utilities, you can use System Utilities to copy, rename, delete, and rearrange the information on disks, but whereas the DeskTop is designed primarily for ProDOS applications, System Utilities supports all three Apple II operating systems: ProDOS, DOS 3.3, and Pascal. Another difference between System Utilities and the DeskTop is that System Utilities is a keyboard-based program while the DeskTop is mouse-based.

- **AppleTalk Utilities:** The AppleTalk utilities on the System Disk make it possible to print Apple II GS documents to a LaserWriter or an ImageWriter™ on an AppleTalk network.

As you can see, there is some duplication in function between the Program Launcher and the DeskTop and between the DeskTop and System Utilities. Experiment with the different utilities and use whichever is most efficient for your applications. You'll find that the Program Launcher is faster than the DeskTop for starting up and switching between ProDOS16 applications. The DeskTop is faster than the Program Launcher for starting up ProDOS8 applications and gives you the added benefit of access to copying, deleting, and other utilities.

- **By the way:** Some editions of the Apple II GS Owner's Guide refer to the DeskTop as the Finder. DeskTop is the correct name for the application on the Apple II GS System Disk that lets you manipulate icons to copy, delete, and otherwise organize the information on ProDOS disks.
After experimenting with the Program Launcher and the DeskTop, you may decide you want to go straight to the DeskTop when you start up the System Disk instead of starting up with the Program Launcher. Here's how to make that change to the System Disk.

1. From the Program Launcher start up DESKTOP.SYS16, open the SYSTEM folder on the System Disk, and change the name of the file called START to something else—LAUNCHER, for example.

2. (Optional.) Move the file called LAUNCHER from the SYSTEM folder to the main directory to make it easier to find from the DeskTop.

*Note:* You'll find instructions for renaming and moving files in Chapter 2.
Chapter 1

Using the Program Launcher
The Program Launcher

The Program Launcher is a mouse-based application that shows you what's on your disks and makes it very easy to start (or launch) applications. It's the first thing you see when you start up the Apple II GS System Disk. See Figure 1-1.

Note: If you've never used a mouse-based application, go through the training disk that came with your Apple II GS before you use the Program Launcher.

To select something, position the pointer on it, and press and release the mouse button. This action is called clicking. Double-clicking means pressing and releasing the mouse button twice. See the Apple II GS Owner's Guide if you have questions about using the mouse and mouse-based applications.

Starting an application

To start an application using the Program Launcher, select the application you want, and click Open. (You can also open an application by clicking twice—that is, double-clicking—on the name.) When you do, you leave the Program Launcher and enter that application.
Subdirectories are explained in the Apple IIgs Owner's Guide.

- Lots of files: If you don't see the application you want to open, click on the arrows in the scroll bar to see other files on the disk.

Opening a subdirectory

If the application you want to open is in a subdirectory, select the subdirectory name and click Open. When you do, you see a list of what's in that subdirectory and you can open one of the subdirectories or applications in that subdirectory by selecting its name and clicking Open. (You can also open a subdirectory or an application by double-clicking the name.) To close a subdirectory, click the Close button and you'll return to the previous directory.

- Dimmed names: If a name or command is dimmed, it means you can't use it. For example, document names are dimmed because the only way to open them is first to open the application you used to create the document.

Opening another disk

If the application you want to open is on another disk, click the Disk button. When you do, the Program Launcher first checks the current drive to see if you've inserted a different disk. If you haven't, it goes on to the next disk drive connected to your computer and displays the contents of the disk it finds there.

Ins and outs

When you quit a ProDOS-based application, you return to the Program Launcher. To get to the Program Launcher after using a DOS 3.3-based or Pascal-based application, you have to restart with the System Disk.

To leave the Program Launcher without opening an application, click the Quit button and follow the instructions on the screen.
Note: From the Quit screen, use the Up Arrow and Down Arrow keys—not the mouse—to select what you want to do next, and then press Return.

Alternative launcher commands

Instead of using the mouse, you may use the following keys to give commands to the Launcher.

Table 1-1
Keyboard equivalent

<table>
<thead>
<tr>
<th>Key Sequence</th>
<th>Equivalent Mouse Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>Click on Disk</td>
</tr>
<tr>
<td>Return</td>
<td>Click on Open</td>
</tr>
<tr>
<td>Esc</td>
<td>Click on Close</td>
</tr>
<tr>
<td>⌘ . (Apple-period)</td>
<td>Click on Quit</td>
</tr>
<tr>
<td>↑, ↓ keys</td>
<td>Click on ↑, ↓ in scroll bar</td>
</tr>
<tr>
<td>any letter</td>
<td>Select the first file whose name starts with that letter but do not open it</td>
</tr>
</tbody>
</table>
The DeskTop is a program that helps you manage the information on your disks by moving *icons*—pictures that represent disks, files, subdirectories, and so on—using the mouse.

- **Note:** You can also give commands to the DeskTop using the keyboard. See “The keyboard and the DeskTop” at the end of this chapter for instructions.

You can also use the DeskTop to see what's on a disk and to start up and switch between applications.

- **By the way:** The DeskTop is designed to work primarily with ProDOS disks and files. You can, however, use the DeskTop to make backup copies of entire DOS 3.3 or Pascal disks. And you can use it to start up any Apple II application disk regardless of its operating system.

---

**Using the DeskTop**

The best way to see how the DeskTop works is to start it up and try it yourself. From the Program Launcher, open the application called DESKTOP.SYS16. After a few seconds, you'll see the computer desktop, a screen similar to the one shown in Figure 2-1. It's called a desktop because, like the desk in your office, it's the place where you lay out the documents and folders you work with.
When you first begin, your computer desktop contains a Trash icon and an icon representing your System Disk. Later in this chapter you'll learn how to open that disk and see what's stored on it. But first, here's a refresher course on using the mouse. If you already know how to use mouse-based applications, skip ahead to the section called "DeskTop fundamentals."

### Using the mouse

Roll the mouse on a flat surface next to your Apple II and watch what happens on the screen. A pointer mirrors every move of the mouse.

If you run out of room for the mouse, lift it and put it down where you have more room. Lifting the mouse does not move the pointer.

### Clicking

Moving the pointer to an icon or button on the screen, and then pressing and releasing the mouse button is called *clicking*. For example, you click icons on the screen to select them.
Clicking twice in rapid succession is called double-clicking. Double-clicking is a shortcut used in many mouse-based applications. You’ll learn where the shortcut leads later in this chapter.

---

**Selecting**

When you point to a word or picture and click, you are *selecting* that word or picture for some action.

Selecting is central to using the DeskTop and other mouse-based applications. You select something and then you tell the DeskTop what action to perform. For example, you might select a disk and then tell the DeskTop to display its contents.

To select an icon, roll the mouse so the pointer is on top of it. Then, click once and the icon will be highlighted.

To deselect an icon, just click somewhere else on the desktop.

---

**Selecting multiple icons**

If you’re copying or deleting several files, you can select all their icons at once. To do this, position the pointer outside one corner of a group of icons, hold down the mouse button, and drag diagonally to the opposite corner of the group. As you drag, you’ll see a rectangle forming. When you release the mouse button, all the icons within the rectangle will be highlighted.

To drag the group to another part of the desktop, position the pointer on any one of the highlighted icons and drag. The icons move together and stay selected until you click anywhere outside any of them.

*Note:* Another way to select multiple icons is to select the first one and then hold down the Apple key (⌘) while you select the additional ones.

---

**Dragging**

To move an icon from one place to another, point to it and hold the mouse button down while you move the pointer to the new location. This is called dragging. The outline of the icon moves as you drag. When you release the mouse button, the icon jumps to the new position.
As you'll learn later in this chapter, you can delete files by dragging them to the Trash or copy files by dragging them from one disk to another.

**Pulling down menus**

The menus in the DeskTop stay out of sight until you need them, but their titles are always visible in the *menu bar* at the top of the screen. To pull down a menu, point to the title of the menu and hold down the mouse button. The menu will remain visible until you release the mouse button.

Some of the commands in a menu may be dimmed when you pull it down. The DeskTop dims commands when they are not appropriate at a particular time.

![Menu title](Menu title)

![Menu bar](Menu bar)

![Selected command](Selected command)

![DeskTop disk](DeskTop disk)

*Figure 2-2*

A menu

**Choosing menu commands**

To choose a command, point to the menu title, hold down the mouse button, and drag the pointer down the list until the command you want is highlighted; then release the button.
Selecting icons and choosing commands go hand-in-hand. You select an icon, then you indicate what action you want to take by choosing a command from a menu. For example, you select a disk icon, then choose the Open command from the File menu to see what's on a disk. When you do, the contents of the disk are displayed in a window like the one shown in Figure 2-3.

Working with windows

The contents of windows will vary, but all of them have these things in common: a title bar, a close box, a size box, and two scroll bars. You can use these tools to change what you see through a window, change the size of a window, move a window, close a window, and activate a window.

For example, when you open the System Disk, you see a screen similar to the one in Figure 2-3. (To open a disk, select the icon and then choose Open from the File menu. You can also open a disk by double-clicking the disk icon.)
Changing the size of a window

A window may be too small for you to see its contents or so big that it obscures other windows on the desktop. To shrink a window, point to the size box and drag it up and to the left. To expand a window, point to the size box and drag it down and to the right.

Moving a window

If you have several windows open at once, and want to see the contents of more than one at a time, you may need to rearrange their position on the desktop. To move a window, point anywhere in the title bar (except on the close box) and, holding down the mouse button, drag the window to wherever you want to put it.

Activating a window

With the DeskTop, you can have several windows open on the screen, but only one can be active at a time. A window has to be active before you can make any changes to the information in it.

You can tell whether a window is active by looking at its title bar. The active window's title bar is striped. To activate a window, click anywhere in the window.

Changing the view through a window

Sometimes a window will show you only part of what is actually on the disk. When the window is too small for you to see all the icons at once, the scrolls bars along the right and bottom sides of the window will be gray and will contain a scroll box. When you drag the scroll box along the scroll bar, different parts of the window come into view.

The vertical scroll bar on the right side of the window represents the total length of the collection of icons; the horizontal scroll bar on the bottom of the window represents the total width. If you want to move down to the middle of the icon collection, for example, drag the right scroll box to the middle of the scroll bar.

To move just a little at a time, click the scroll arrow that points in the direction of what you want to see, or click in the gray areas of the scroll bar.
Closing a window

To close a window, click the close box in the upper left corner of the window. This has the same effect as choosing the Close command from the File menu.

DeskTop fundamentals

The next few sections explain the most basic way to use the DeskTop to manage your files and start your applications. When you’re ready to see what else the DeskTop can do, read “DeskTop commands” later in this chapter. It reviews all the menus, command by command.

Viewing the contents of a disk

When you open a disk, the DeskTop displays the files on that disk as icons in a window. By using the commands on the View menu, you can see more information about these files and change the order in which they are displayed. Try this:

1. Select and open a disk.
2. Choose By name from the View menu. (The DeskTop lists the files on the disk alphabetically by name and also provides other information about the file.)
3. Select another command from the View menu to organize the files a different way. Then, select By icon to return to the familiar view.

Warning

When you’re using the DeskTop, don’t insert two disks with the same name at the same time or the program won’t know which disk you want to work with.

Copying files

Copying a file from one disk to another is as simple as dragging a document icon to a disk icon. When you drag the icon of a file from one disk to another, the DeskTop copies the file onto the new disk. When the process is complete, the original file is still on the first disk and a copy of it is on the second disk.
To copy a file from one disk to another, follow these steps:

1. Open the source disk and select the file to be copied.
2. Drag the file icon to the destination disk icon. (You don't have to open the destination disk.)
3. When the destination disk is highlighted, release the mouse button.

The DeskTop displays an information screen as it copies the file.

You can copy a number of files at once by selecting multiple icons and dragging the whole group to the destination disk. Make sure the destination disk is highlighted before you release the mouse button.

**Copying over existing files**

The DeskTop warns you if the file you are copying already exists on the destination disk and asks if you want to write over it. If you are copying a newer version of a file, for example, click Yes. If you're unsure, click Cancel and check to see what's in the other file before you copy over it.

*Note:* If you are copying multiple files over existing files, you can click All and the DeskTop will copy them all, without asking for confirmation each time.

**Organizing files into folders**

If you're copying an application which is made up of several files, it's a good idea to copy the application into a folder. A folder keeps the files together in case you want to move them again, and keeps your desktop from getting cluttered.

1. Open the destination disk.
2. Choose New Folder from the File menu.
3. You'll see a message that asks you to type the folder's name. Type a name for the folder and click OK. Make sure the folder name is no longer than 15 characters.
4. Drag the files you want to put in the folder onto the folder icon, and release the mouse button when the folder icon is highlighted.

---

 DeskTop fundamentals 13
• Note: When you copy files into a folder, the original files remain where they were. Delete these originals if you want to by dragging them to the Trash. Deleting files is explained in the next section.

Deleting files

To delete a file, drag its icon to the Trash and release the mouse button when the Trash icon is highlighted. A dialog box will appear indicating that when you click OK, your files will be permanently removed. If you’re sure that’s OK, click OK.

You can delete a number of files at once by selecting multiple icons and dragging the whole group to the Trash.

Warning

Once files have been deleted, they cannot be recovered.

Formatting a disk

Before you can save documents on a blank disk, you have to format the disk. Use Format a Disk on the Special menu when you want to prepare a blank disk for use with ProDOS applications.

• Formatting for Pascal: If you want to format a blank disk for use with or Pascal-based applications, use the System Utilities formatter explained in Chapter 3.

Follow these steps, and the directions on the screen, to format a disk:

1. Insert the disk to be formatted into any drive.
2. Choose Format a Disk from the Special menu.
3. Select the location of the disk and click OK.
4. Type a name for the disk and click OK.
5. If asked, confirm that you want to erase the current contents of the disk.

Warning

Formatting a disk erases everything stored on the disk, so you should only format blank disks or disks you want to erase and recycle.
- Recycling tip: If a disk has already been formatted for the Apple II and you just want to erase it, it's faster to use the Erase a Disk command on the Special menu.

## Copying a disk by dragging an icon

If you have two drives of the same size (for example, two 3.5-inch disk drives), you can make a backup disk just by dragging the source disk icon to the destination disk icon.

To copy a disk, follow these steps:

1. (Optional, but highly recommended.) Write-protect your source disk.
2. Insert the source disk into any drive.
3. Insert the destination disk, newly formatted or erased, in the other drive.
4. Drag the source disk icon to the destination disk. Release the mouse button when the destination disk icon is highlighted.

The DeskTop displays an information screen during the copying process.

- Note: You can also make a backup by copying the disk contents onto a larger capacity disk—for example, copying a 5.25-inch disk onto a 3.5-inch disk. In this case, the destination disk does not have to be newly formatted, but it must have enough space for all the files you will be copying.

Pressing Esc (Escape) in the middle of a disk copy stops the procedure as soon as the current file has been copied.

## Copying a disk using only one drive

If you have only one drive of a particular size, use Disk Copy from the Special menu to make a backup. (See “Disk Copy” later in this chapter for information on other uses of this command.)

Follow these steps and the directions on the screen to copy a disk:

1. (Optional, but highly recommended.) Write-protect your source disk.
2. Choose Disk Copy from the Special menu. You'll see the Quick Copy window.
3. Choose Disk Copy from the Facilities menu.
Slot refers to the slot inside your computer containing your disk drive controller card. See "Slot and drive" in Chapter 3.

4. When you see Select source disk, select the slot and drive you want to use and click OK.

5. When you see Select destination disk, select that slot and drive again and click OK.

6. Insert the source and destination disks in turn as prompted on the screen.

7. If asked, confirm that you want to destroy the contents of the destination disk.

8. Continue to insert the source and destination disks as prompted until the copy process is complete.

At this point, the DeskTop displays the Copy Disk screen again. Select Quit from the File menu to return to the desktop.

Note: You can stop the copy at any time by pressing the Esc key. Then, click OK to return to Copy Disk. After that, you can start again, or choose Quit from the File menu to return to the desktop.

Starting applications

To start applications from the DeskTop, just follow these steps:

- Select the disk icon and choose Open from the File menu, or double-click the appropriate disk icon to open it and see its files.

- Select the program icon and choose Open from the File menu, or double-click the program you want to run. (If an application comprises several files, open the icon whose filename includes the word System, such as Aplworks.System.)

- BASIC programmers: To run a BASIC program from the DeskTop, there must be a copy of the file called BASIC.SYSTEM on the same disk as your program, and the BASIC.SYSTEM file must be in the same directory or in a higher-level directory than the program. For example, you could have BASIC.SYSTEM and your program files in the main directory, or you could have BASIC.SYSTEM in the main directory and your program files in a subdirectory.
Returning to the DeskTop

Most applications have a quit option. When you choose the quit option and have launched that program from the DeskTop, you should find yourself back in the DeskTop program. If you don't, you can get back to the DeskTop by restarting the System Disk and opening the application called DESKTOP.SYS16.

DeskTop command reference

The rest of this chapter is a quick reference for users who want to explore more of the DeskTop's capabilities.

The commands are discussed in the order that they appear on the menu bar. Each menu item is explained.

The desk accessories menu

The Apple symbol ( inflammable icon) menu contains desk accessories—miniature applications like a calculator and a puzzle.

When you finish using a desk accessory, click the close box in the upper-left corner of the window.

Calculator

The Calculator works like a four-function calculator. Click the number buttons and function buttons to perform quick calculations.

❖ *Note:* The key marked *e* stands for exponent.

Puzzle

The puzzle is just for fun. Click on any tile to begin, then click a tile to slide it into the empty space. The object is to arrange the tiles into the Apple logo.
Date

The Date accessory displays the date which the DeskTop uses to mark a file’s creation or modification date.

To change the date setting, use the Control Panel.

Show Text File

This accessory lets you view the contents of a file in ASCII format. You can’t edit the file in this format, but it gives you a way to see what’s in a particular file without having to leave the DeskTop and start up the application you used to create it.

Sort Directory

This accessory lets you designate how file icons will be arranged when you first open a disk or folder. This lets you store the icons you use most frequently at the top of the window.

To sort a directory, hold down the Apple key (⌘) and click the icons in the order you want them to appear in the window. After you’ve clicked all the icons you want to arrange, choose Sort Directory, and the first icon you clicked will appear in the upper-left corner, the second icon you clicked will be just to the right of that, and so on.

*Note:* You can rearrange icons by dragging them, but they will revert to their original positions the next time you open that window unless you use Sort Directory to reposition them.

The File menu

These commands are used for most of your work with disks and files.

New Folder (⌘ - F)

This command puts an empty folder in the active disk or folder window. The DeskTop asks for the new folder’s pathname. The first part of the pathname is provided, so all you have to type is a name for the folder and click the OK button.

Use folders to organize your files into a few general categories or to hold the files of an application program.
When you drag an icon into a folder, the original icon remains where it was. So if you use folders to clean up your desktop, make sure to delete duplicate files.

* Note: When a file is in a folder, the folder's name becomes part of the file's pathname.

**Open (Ô - O)**

Selecting a disk or folder icon and choosing Open displays the contents of the disk or folder. Selecting an application icon and choosing Open starts the program.

**Close (Ô - C)**

An alternative to using the close box, this command closes the active window.

**Close All (Ô - B)**

This command closes all the windows on the desktop.

**Select All (Ô - A)**

Select All highlights all the icons in the active window. If no windows are open, the command highlights all the icons on the desktop.

**Copy a File (Ô - Y)**

Copy a File is an alternative to copying a file by dragging an icon. When a file is deep within directories, using this command may be faster.

To enter the source name, change the drive, if necessary, open the appropriate folders, and select the filename. When you click OK, the DeskTop enters a default destination pathname. Accept this pathname, or edit it, using the mouse or the keyboard.

When the pathnames are correct, click the OK button.

* Note: To copy a whole disk, use the Disk Copy command in the Special menu.
Delete a File (⌘ - D)

Use Delete a File as an alternative to deleting a selected file by dragging an icon to the Trash. This command may be quicker when the file is deep within a directory.

Eject (⌘ - E)

This command ejects the selected 3.5-inch disk from its drive.

Quit (⌘ - Q)

This command displays the Selector if there are entries in the Run list. Otherwise, it returns to the desktop.

*Note: You'll learn more about the Selector in the section called “The Selector Menu” later in this chapter.*

---

The View menu

The DeskTop gives you several different ways to display the contents of disks and folders. One way is by icon. You must display files and folders as icons in order to copy and delete them by dragging. But other views have their advantages. This section explains what your options are.

By icon (⌘ - J)

The By icon view is the default view. It shows the contents of the active window as icons.

By name (⌘ - N)

This command shows the contents of the active window alphabetically, by name.

By date (⌘ - T)

This command shows the contents of the active window chronologically, by last modification date.
By size (O - K)

By size shows the contents of the active window in descending order, by size.

By type (O - L)

The By type command shows the contents of the active window, alphabetically, by file type.

The Special menu

These commands are used for working with disks and files, but less frequently than those in the File menu.

Check Drives

This command lets you update the desktop after you change the disks in the drives.

Note: You need to use this only for 5.25-inch disk drives; the DeskTop checks the 3.5-inch disk drives automatically.

Format a Disk (O - S)

Format a Disk prepares a disk for ProDOS files. If a disk has already been formatted, use Erase a Disk to remove the old data.

Erase a Disk (O - Z)

This command removes all old data from a disk. Erasing is much faster than formatting. When you use this command, you'll be asked to enter a name for the new volume. In this case, volume is synonymous with disk. See Chapter 3 for more about volumes.
Disk Copy

Use this command to make a backup copy of a disk. It's faster than copying a disk by moving its icon. And, it's the only way to copy a disk when the disk format is DOS 3.3 or Pascal or when you want a same-size copy (for example, 3.5-inch to 3.5-inch) and you have only one drive of that size.

This command provides two copy programs. Quick Copy is the default, but you can use it only with ProDOS disks and when the destination disk is already formatted.

To copy a disk using Quick Copy:
1. Follow the instructions on the screen to select the source and destination drives. Insert the source and destination disks as prompted.
2. Select Quit from the File menu to return to the DeskTop.

To use the other copy program, select Disk Copy from the Facilities menu. The instructions are the same as for Quick Copy.

Note: If a disk has a non-standard operating system (something other than ProDOS, DOS 3.3, or Pascal), you may not be able to copy it. Consult that program's manual for instructions about making backup copies.

Lock

Lock prevents the contents of a file or disk from being inadvertently changed, discarded, or renamed.

Unlock

This command reverses Lock.

Get Info (C - l)

Get Info displays information, such as size and creation date, about a selected file or disk. If you select multiple files before choosing Get Info, click the OK button to display successive information screens.
Get Size

Use this command to check the total size of a group of files you have selected. Click OK to return to the desktop.

Rename an Icon

Use this command to change the name of a file, folder, or disk. Rename an Icon is available when any icon but the Trash is selected.

The Startup menu

The DeskTop only displays icons for ProDOS disks. But you can start up an application on a non-ProDOS disk by using the Startup menu.

Warning

Be sure that the disk you want to start contains an application. If you use a data disk, for example, the DeskTop will stop and you’ll have to restart it.

Insert the disk in a drive, and choose the appropriate slot from the menu; the DeskTop will start it.

Note: In most cases, your drives will be attached in such a way that selecting Slot 5 will start up 3.5-inch disks and selecting Slot 6 will start up 5.25-inch disks.

The Selector menu

These commands let you create a Run list for quick program selection. Items in the Run list also appear on the Selector, so you can run them at startup without going to the desktop.
Add an entry

This command adds items to the Run list.

The DeskTop lets you put up to eight items on the Run menu. An additional 16 may be stored in the Other Run list; both lists are displayed in the Selector. Click the appropriate box on the far right side of the command screen to put an entry in the Other Run list.

1. Enter the program name by selecting its drive, opening a folder, if necessary, and selecting its filename. Click OK and then type the name as you want it to appear in the Run list or accept the name suggested by the DeskTop.

2. If you have a RAM card and want the DeskTop to download a Run list program, click the appropriate box on the right side of the screen.

3. Click OK when all the screen entries are correct.

Warning

Be sure that the entries in the Run list are applications. If they are not, the DeskTop may stop and you will have to restart it.

Edit an entry

Use this command to change an entry on the Run list. Follow the instructions on the screen to select the entry, correct the information displayed, and then click OK.

Delete an entry

This command removes an entry from the Run list. Follow the instructions to select the entry and then click OK. Click Cancel to return to the desktop.

Run an entry (Ø - Ø)

This command displays the contents of both the Run list and the Other Run list.
The keyboard and the DeskTop

If you prefer, you can control the DeskTop with keystrokes instead of with the mouse. This section explains how to select icons, pull down menus, choose from menus, and manipulate windows without using the mouse. If you like using the mouse, skip this section.

Selecting icons with keystrokes

Press ⌘-H to highlight an icon. Press Right Arrow or Left Arrow to highlight a different icon on the desktop or in the active window. When the appropriate icon is highlighted, press Return to select it.

Press ⌘-A to select all the icons on the desktop or in the active window.

Choosing menu commands with keystrokes

Press Esc (Escape) to indicate that you want to choose a command from a menu. When you do, a menu is pulled down. Press Left Arrow or Right Arrow to pull down a different menu. Press Up Arrow or Down Arrow to highlight the command you want, then press Return to choose the selected command, or type the key combination shown to the right of the command name.

Controlling windows with keystrokes

Press ⌘-W to activate a window. Press Left Arrow or Right Arrow to activate other windows on the desktop. Press Esc to leave this mode.

Press ⌘-G to indicate that you want to change a window’s size, then use the arrow keys to change the size. Press Return to select the new size.

Press ⌘-M to indicate that you want to move a window, then use the arrow keys to move the window. Press Return to select the new position.

Press ⌘-X to indicate that you want to scroll through the contents of a window, then use the arrow keys to scroll.
Table 2-1 shows the key combinations you can use instead of choosing commands from menus.

### Table 2-1

Keyboard equivalents for menu commands

<table>
<thead>
<tr>
<th>Typing this</th>
<th>Does this</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ - F</td>
<td>Creates a new folder</td>
</tr>
<tr>
<td>⌘ - O</td>
<td>Opens selected icon</td>
</tr>
<tr>
<td>⌘ - C</td>
<td>Closes an active window</td>
</tr>
<tr>
<td>⌘ - B</td>
<td>Closes all windows</td>
</tr>
<tr>
<td>⌘ - A</td>
<td>Selects all icons in active window or on desktop</td>
</tr>
<tr>
<td>⌘ - Y</td>
<td>Copies selected file</td>
</tr>
<tr>
<td>⌘ - D</td>
<td>Deletes selected file</td>
</tr>
<tr>
<td>⌘ - E</td>
<td>Ejects selected file</td>
</tr>
<tr>
<td>⌘ - Q</td>
<td>Quites DeskTop returns to Program Launcher</td>
</tr>
<tr>
<td>⌘ - J</td>
<td>Displays directory as icons</td>
</tr>
<tr>
<td>⌘ - N</td>
<td>Displays directory arranged alphabetically by name</td>
</tr>
<tr>
<td>⌘ - T</td>
<td>Displays directory chronologically</td>
</tr>
<tr>
<td>⌘ - K</td>
<td>Displays Directory arranged numerically by size</td>
</tr>
<tr>
<td>⌘ - L</td>
<td>Displays Directory arranged by file type</td>
</tr>
<tr>
<td>⌘ - S</td>
<td>Formats a disk</td>
</tr>
<tr>
<td>⌘ - Z</td>
<td>Erases Selected disk</td>
</tr>
<tr>
<td>⌘ - I</td>
<td>Gives info about selected icon</td>
</tr>
</tbody>
</table>
A file is any body of information stored by name on a disk. It could be a document, an application, or a subdirectory. A subdirectory is the disk equivalent of a file folder. It gives you a way of keeping related documents together.

Here are some of the things you can do with System Utilities:

- format disks of any size (5.25-inch, 3.5-inch, hard disks, RAM disk)
- organize related files through the use of subdirectories (ProDOS only)
- copy files from one disk to another
- rename disks and files
- delete files
- copy entire disks
- list the names and characteristics of files on a disk
- check disks to verify that they are usable

Formatting tip: Many application programs designed for earlier models of the Apple II have built-in utilities that can format 5.25-inch disks but can't format 3.5-inch disks. If you run into this problem, use System Utilities to format several 3.5-inch disks so you'll have a supply of formatted disks when you need them.

General instructions

The quickest way to learn how to use the System Utilities application is to start using it. You'll find most of the instructions you need right on the screen. If you don't understand what you're supposed to do at a particular point in the program, hold down the Apple key while you press ? and additional instructions will be displayed on the screen.

The only tricky part of using System Utilities is understanding the terminology. What's a volume, what's a file, what's a subdirectory, what's a pathname, and how do you figure out a disk's slot and drive number? The next few sections answer these questions.
Volumes, files, and subdirectories

A **volume** is a place where data is stored. If you're dealing with 3.5-inch disks and 5.25-inch disks, **volume** is just another word for **disk**. So, if a program asks for volume name, just type the name of your disk. With large-capacity devices like hard disks, you can have more than one volume on a disk. But if you haven't divided your hard disk into partitions, **volume name** and **disk name** are synonymous.

A **file** is any body of information stored by name on a disk. It could be a document, an application, or a subdirectory.

A **subdirectory** is a file that points to the locations of other files on a disk. Subdirectories give you a way of keeping related documents together, the same way that folders keep related documents together in desk drawers.

Slot and drive

**Slot** refers to the slot inside the computer containing your disk drive's controller card.

If your disk drive is connected to the disk drive port instead of to an interface card in a slot, and you're asked for a slot number, answer slot 6 for 5.25-inch drives and slot 5 for a RAM disk and for 3.5-inch drives.

You can have up to two drives connected to each slot, so you'll also be asked for a drive number. The drive connected to the computer is drive 1; the drive connected to drive 1 is drive 2. With a RAM disk, determining drive numbers is a little trickier because the drive number depends on whether you've designated the RAM disk as your startup device. Use the following chart to figure out which slot 5 device is drive 1, drive 2, and so on. Note that if you have more than two slot 5 devices, the third device corresponds to slot 2.
### Table 3-1
Slot and drive

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Drive</th>
<th>Corresponding slot and drive</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAM disk is not startup device</td>
<td>3.5-inch drive 1</td>
<td>slot 5, drive 1</td>
</tr>
<tr>
<td></td>
<td>RAM disk</td>
<td>slot 5, drive 2</td>
</tr>
<tr>
<td></td>
<td>3.5-inch drive 2</td>
<td>slot 2, drive 1</td>
</tr>
<tr>
<td>RAM disk is the startup device</td>
<td>RAM disk</td>
<td>slot 5, drive 1</td>
</tr>
<tr>
<td></td>
<td>3.5-inch drive 1</td>
<td>slot 5, drive 2</td>
</tr>
<tr>
<td></td>
<td>3.5-inch drive 2</td>
<td>slot 2, drive 1</td>
</tr>
</tbody>
</table>

#### ProDOS pathname

A **pathname** is the complete name of a file, starting with the name of the disk it's on, the subdirectory it's in, and the filename. A pathname starts with a slash, and each component of the name is separated by a slash.

The pathname for a file called MOM in a subdirectory called LETTERS on a disk called MY.DISK would look like this:

```
/MY.DISK/LETTERS/MOM
```

ProDOS is the only Apple II operating system that supports the use of subdirectories. If you're working with DOS 3.3 or Pascal disks, you won't be able to identify files by pathname.

#### Using System Utilities

Once you understand what slot numbers, drive numbers, and pathnames are, you won't have any trouble using System Utilities. Remember, hold down the Apple key while you press `?` if you have questions.
Starting up

Start up System Utilities. To start up System Utilities from the Program Launcher, open the subdirectory called SYS.UTILS, and then open the application called SYSUTIL.SYSTEM. You should see the main menu, as shown in Figure 3-1.

![Figure 3-1](image)

System Utilities main menu

The System Utilities main menu shows you most of the things you can do with the System Utilities application. The options on the left are operations you can perform on disks. The options on the upper right are operations you can perform on files. The options on the lower right are operations you can perform only on ProDOS disks.

Selecting from a menu

To select an option from a System Utilities menu:

- Press Up Arrow, Down Arrow, Left Arrow, or Right Arrow until the option you want is highlighted.
- Press Return.
For practice, press Down Arrow until About the IIGs System Utilities is highlighted. Then press Return. When you’ve finished reading about System Utilities, press Return to get back to the main menu.

*Note:* You can’t use the mouse with System Utilities.

---

**Selecting the location of disks or files**

Once you *pick the* utility you want to use, you’ll be asked to select the location of the disk you’ll be working on, or the files you’ll be working with, by slot and drive or by ProDOS pathname.

![Figure 3-2](image)

*Figure 3-2*

*Where is your disk?*

If you’re working with a Pascal or DOS 3.3 disk, you must use the slot and drive method of indicating where your disk or files are because neither DOS 3.3 nor Pascal supports the use of subdirectories. If you’re working with a ProDOS disk, you can indicate where the disk or files are either by slot and drive or by pathname.

*Note:* If you use subdirectories, you must use the pathname option to give the location of files.
Changing slot and drive

If you choose slot and drive as the way of indicating the location of your disk or files, you'll see the words Slot and Drive with a number next to each. (See Figure 3-3.) Select the number you want to change by pressing Right Arrow or Left Arrow; then change the number either by typing a number or by pressing Up Arrow or Down Arrow. When the slot and drive numbers are correct, press Return.

![Figure 3-3](image)

Slot and drive
Entering a ProDOS pathname

If you choose ProDOS Pathname as the way of indicating the location of your files, you'll see the words Enter ProDOS Pathname and a blinking cursor followed by a line of dots. If you've set a prefix, just type the rest of the pathname and the prefix will be affixed to the front of what you type. If you haven't set a prefix, or if you want to override the prefix, type the complete pathname, starting with the name of the disk. Press Return when you finish typing the pathname.

Selecting files

With utilities that work on files, you'll be asked if you want to work with some or all of the files on the disk.

If you choose some files, you'll see a list of all the filenames on the disk or in the subdirectory, and you'll be asked to mark the files you want to copy, delete, or rename.

Use Up Arrow or Down Arrow to highlight the file you want to work with; then press the Space bar to mark it. A check mark will appear next to each file you mark. To unmark a file, press Space again.

If there are a large number of files to choose from, they'll be displayed in two or more columns. Use the Tab key to move from one column to another.

When you've marked all the files you want to work on, press Return.
Naming disks and files

If a utility asks you to type a name for a disk or file, it will usually provide a default (suggested response) for you. You can use the default name by pressing Return, or you can type a new name.

Rules for naming disks and files

You can make up any name you like, within these guidelines:

- Names must begin with a letter.
- Names must be made up of only letters, numbers, and periods.
- Names can have no spaces or punctuation marks other than periods.
- ProDOS names can't have more than 15 characters. (Pascal volume names can have only 7 characters. Pascal filenames can have 15 characters.)

Tips for naming disks and files

You may find these tips useful in making up names:

- Keep the name as short as possible to save yourself some typing.
- Choose a name that suggests the contents of the disk or file.
- Use periods where you would ordinarily put spaces; for example, Chapter.1 or Jones.memo.
- Start the names of related files with the same few letters. For example, you might name your letters to mother Mom1, Mom2, and Mom3. Most utilities and applications display lists of filenames alphabetically, so the names of related files will be shown together.
If several people use the same disk, create a separate subdirectory file for each person, perhaps using that person's name as the name of his or her subdirectory. These subdirectories will keep everyone's files separate and eliminate the likelihood of two people using the same filename.

\* Note: Files can have the same name as long as they're in different subdirectories.

**Editing names**

You can edit any default name by using Left Arrow and Right Arrow to position the cursor and insert new characters. Pressing Delete erases the character above the cursor. Pressing Control-Y deletes all the characters to the right of the cursor. Pressing Control-X deletes all characters in the same line (so you can start typing a new name).

Press Return when you finish entering or editing a name.

**Stopping**

When you finish using System Utilities, press Esc to get back to the main menu, select the Quit option on the main menu. You'll be asked if you're sure you want to leave System Utilities. If you're sure, select Yes and press Return. If you don't really want to quit, select No and press Return and you'll return to the System Utilities main menu.

\* Note: Pressing Esc in the middle of a utility returns you to the main menu at the earliest nondestructive opportunity.
Functions of System Utilities

The following sections describe each option on the System Utilities menu in the order of appearance.

Catalog a Disk

Catalog a Disk gives you a list of all the files on a disk. In addition to telling you which files are in a disk's directory, this option tells you the disk's operating system, the disk's name (or number, in the case of DOS 3.2 or DOS 3.3 disks), each file's type, each file's size, the number of files on the disk, the number of blocks or sectors taken up by the files, and how many blocks or sectors are available on the disk.

If you respond to the question Where is your disk? by typing a slot and drive number, you'll see information about everything in the main directory of the disk in the drive connected to that slot. If there are subdirectories on the disk, they will be labeled with the file type Directory (short for directory) and you won't see the names of the files in the subdirectories. To see what files are in a particular subdirectory, you need to select ProDos pathname from the Catalog a Disk screen and then type the pathname of that subdirectory.

List Volumes

List Volumes gives you a list of all the drives that are connected to your computer, along with the slot and drive numbers corresponding to those devices, and the names of the disks that are in those drives.

Duplicate a Disk

Duplicate a Disk lets you make an exact copy of a disk. It's a good idea to make backup copies of all your disks in case anything happens to the originals.
Note: You can't use Duplicate a Disk to copy the contents of a 3.5-inch disk onto a 5.25-inch disk or to copy the contents of a 5.25-inch disk to a 3.5-inch disk. You must use the Copy Files option to copy between disks of different size. The only time you can use Duplicate a Disk to copy between unlike disks is if you set the maximum and minimum size of your RAM disk to 800K (which is the storage capacity of a two-sided 3.5-inch disk). If you do that, you can use Duplicate a Disk to copy the contents of your RAM disk to a 3.5-inch disk or to copy the contents of a 3.5-inch disk to a RAM disk.

Format a Disk

Format a Disk lets you prepare a blank disk for storing data. The Format a Disk option will ask you to select an operating system. If you don't know what operating system your application requires, select the last option and the utility program will figure it out for you by examining your application disk.

Programmer's Note: Pascal disks formatted by System Utilities can only be used as data disks, not as startup disks. If you want to format a disk, use FORMATTER.CODE supplied with your Pascal system.

If you try to format a disk that has files on it, the program will ask Is it okay to destroy the disk? Select Yes to format the disk or No if you've made a mistake and have the wrong disk in the drive.

Warning

When you format a disk, everything stored on the disk will be destroyed.

The only time you don't have to format blank disks before you use them is when you use the Duplicate a Disk option. Duplicate a Disk formats the destination disk before copying information to it.
Other Options

Additional utilities are available when you choose Other Options from the main menu. Press Esc to get back to the main menu from the Other Options menu.

Verify That a Disk Is Readable

Verify That a Disk Is Readable checks to see if a disk is OK. It's a good idea to use this option to check newly formatted disks before entrusting valuable data to them. You can also use this utility to check disks you suspect have been damaged. If you discover that a disk is bad, use Copy Files to copy those files that are still usable to another disk. Then reformat the disk and check it again, using this utility. If it's still bad, throw it away.

Copy Files

Copy Files lets you copy a file or files from one disk to another or from one subdirectory to another on the same disk.

If you want to copy all the files from one disk to another disk, it's faster to use the Duplicate a Disk option (but you can do this only if the disks are the same size).

Important

Make sure your destination disk (the disk you're copying to) has the same format as your source disk (the disk you're copying from). If the source and destination disks have different formats (if one is ProDOS and the other is DOS 3.3), the files will be converted to the new format as they are copied and they won't be recognizable to the application program you used to create them.
When copying files to or from a subdirectory, you must indicate the location of your files by using the ProDOS pathname option when you're asked for the location of the source and destination disks. You can copy all the files in a subdirectory simply by copying the subdirectory name. If you are copying files to a subdirectory from a list of files that also contains the name of the same subdirectory (indicated by a slash following the name), be careful not to select the subdirectory name from that list (because you don't want to copy the subdirectory into itself).

---

### Delete Files

Delete Files lets you permanently erase files that have outlived their usefulness so you can reuse the disk space.

If you want to delete everything on a disk, it's faster to use the Format a Disk option.

If you are deleting files from a subdirectory, you must indicate the location of the files by using the ProDOS pathname option when you're asked Where is your disk?

For your own protection, you can't delete a subdirectory unless all the files in that subdirectory have been deleted first. If you try, you'll get the message Subdirectory is locked.

---

### Rename Files

Rename Files lets you rename a file without changing its contents. If you are renaming files in a subdirectory, you must indicate the location of the files by using the ProDOS pathname option when you are asked Where is your disk?

---

### Lock/Unlock Files

Lock/Unlock Files lets you lock files so you don't delete them, rename them, or change their contents by mistake. If you're sure you want to delete or alter a locked file, you can also use this option to unlock it.
If you are locking or unlocking files in a subdirectory, you must indicate the location of the files by using the ProDOS pathname option when you are asked Where is your disk?

*Note:* You can't lock or unlock files on a Pascal-formatted disk.

---

**Create Subdirectory (ProDOS only)**

A subdirectory is a file that points to the locations of other files on a disk. Creating a subdirectory and copying files into that subdirectory allows you to work with a subset of the files on a disk instead of hunting through your whole disk for related files.

Before you can put files in a subdirectory, you have to create the subdirectory by using this option. Once you've created a subdirectory, you can use the System Utilities Copy Files option to put files in the subdirectory.

If you're going to be using files within the same subdirectory for a while, you can save typing time by setting a prefix. Setting a prefix is explained in the next section.

*Note:* Some ProDOS applications will let you create a subdirectory from within the application. This has the same effect as creating a subdirectory by using System Utilities. All ProDOS applications will give you the option of saving files by using a pathname. This allows you to save files directly into a subdirectory instead of having to copy them into a subdirectory by using the System Utilities Copy Files option.

---

**Set Prefix (ProDOS only)**

Set Prefix lets you store the first part of a pathname (the disk name and any subdirectory names) in the memory of the computer so you can access files in that subdirectory simply by typing the rest of the pathname (usually just the filename).

Setting the prefix is very useful when you want to work with the files in a particular subdirectory. Setting the prefix focuses your view to just that group of files.
Once you set the prefix, it stays set until you change it, turn off the computer, or start another application. Most ProDOS applications give you a way of setting a prefix so you don’t have to type the entire pathname every time you want to save a file into a particular subdirectory or load a file from a particular subdirectory.

**Rename Volumes (ProDOS only)**

Rename Volumes gives you a chance to change the name of a disk without changing its contents.

**That’s it**

Remember, the best way to learn how to use these utilities is to use them. Try formatting a practice disk with the operating system used by your favorite application. If it’s a ProDOS disk, create some subdirectories on it. Then quit System Utilities, start up the application, create some short sample files, and save them on the disk you just formatted. Once you’ve done that, start up System Utilities again and practice copying those files, deleting them, renaming them, and so on. Once you feel confident using System Utilities with disposable files, you’ll have no trouble using it on your real work files.

If you have any questions as you’re using System Utilities, press ⌘-? and you’ll get help that pertains to what you were doing when you pressed the help keys.
Chapter 4

AppleTalk Network Utilities
To use an ImageWriter as a network printer, you need to get the ImageWriter AppleTalk option.

**About network utilities**

Besides the utilities that let you copy, delete, rename, and otherwise organize the information on disks, there are also utilities on the System Disk for AppleTalk network users. These utilities, called the *Namer* and the *Chooser*, let you name the printers you share with others on an AppleTalk network and choose which of those printers to print with.

If you have two LaserWriter printers or two ImageWriter printers on your network, it's important to have some way of distinguishing them from each other so you know where to look for your printed document. (If you have one LaserWriter, you don't really need to name it—it's called *LaserWriter* if you don't name it something else—but for the same reason that people name cars and boats, you might enjoy giving your printer a name.) Naming a printer is something that anyone on the network can do, but it needs to be done only once, by one person.

---

**Important**

If you change the name, you should inform everyone on the network because they'll need to use the Chooser to choose the new name before they can print anything.

While the Namer is something you need use only once, the Chooser is something you must use every time you start or restart the computer. Using the Chooser loads special software into RAM that tells the application how to use the network.
See the *Apple II GS Owner’s Guide* for instructions on using the Control Panel.

---

**Preliminaries**

Before you can use the Namer or the Chooser, your computer must be connected to the AppleTalk network (see Figure 4-1) and your computer’s Control Panel must be set up for using AppleTalk (see Figure 4-2).

![Figure 4-1](image1)  
**AppleTalk cable plugged in**

![Figure 4-2](image2)  
**Control Panel set up**

Once you’ve done that, you can name the printers on the network by using the Namer, choose one of them to use for printing by using the Chooser, and print to that printer from your application—provided your application uses a version of ProDOS that supports the AppleTalk network (version 1.2 or later) and has been configured to print to a network printer.

You’ll find instructions at the end of this chapter on how to prepare AppleWorks for use with a network printer.
To choose something, click it: that is, move the mouse until the pointer is pointing to it, then press and release the mouse button.

Using the Namer

1. Turn on the printer you want to name.

2. Start up the System Disk, open the subdirectory called APPLETALK, and then open the application called NAMER. When you do, you'll see the screen shown in Figure 4-3.

3. Choose the type of device you want to name from the device list by clicking it. The cursor changes to an hourglass while the Namer checks the network for all devices of that type and displays a list of devices and their current names in the Names window.

4. Choose the device you want to name from the list of printers shown on the left side of the Namer screen by clicking it. When you do, the insertion point will automatically move to the new name box.

5. Type a new name or edit the current name.

6. Click the Rename button.

7. Click Quit.

8. Tell everyone on the network that you just renamed one of the printers.

Choose type of device
Choose device
Type a name

Figure 4-3
Namer
Using theChooser

1. Start up the System Disk, open the subdirectory called APPLETALK, then open the application called CHOOSER. When you do, you'll see the screen shown in Figure 4-4.

2. Choose the type of printer you want to use by clicking it.

3. (Optional.) If your network is set up with several AppleTalk zones, choose the zone that your printer belongs to by clicking a zone. (If you don't know what the zone is, your network probably isn't divided into them. If you have any questions, ask the person who laid out the network.)

4. Choose the printer you want to use from the list on the right side of the screen by clicking it.

\* LaserWriter note: If you're printing with a LaserWriter, you'll see a message that says Checking for presence of ImageWriter emulator. If no one has printed with that printer since it was turned on, you'll also see the message Downloading ImageWriter emulator.

5. Click the box that says User name and type your name. Some applications use the information in User Name to let other people know who is currently using the printer.

---

The ImageWriter emulator is a program that makes it possible to use a LaserWriter with any application designed to print with an ImageWriter.
• **Mouseless operation:** You can also change settings in the Namer and Chooser by using the keyboard. Pressing Tab moves the cursor from one field to the next. Pressing Up Arrow, Down Arrow, Left Arrow, and Right Arrow changes the selected item. Pressing Return chooses the selected item.

• **More choices:** The Quick menu gives you two more ways to move from one field to another. You can choose a field from the menu or use the keystroke combinations shown to the right of each field to jump to the device menu, the zone, the user name, and so on.

---

**Preparing applications for network printing**

You need to use the Namer only once, but you must use the Chooser everytime you start or restart the computer.

If the disk with your application doesn't have a Chooser, start up your System Disk and use the Chooser on the System Disk to pick a printer. Then use the Program Launcher to start the program you want to use.

If your application isn't copy-protected, you might want to copy your application files to a copy of your System Disk so the Chooser and the application will be on one disk.

The following instructions show how to copy an application program like AppleWorks™ to a copy of your System Disk and how to prepare AppleWorks to print with a network printer.

---

**AppleWorks meets AppleTalk**

1. Make a copy of your System Disk.

2. Delete the SYS.UTILS folder from your copy of the System Disk to make room for the AppleWorks files. (This deletes System Utilities, but you shouldn't need it with AppleWorks.)

3. Copy the contents of your AppleWorks program disk to the System Disk by dragging the AppleWorks disk icon to the System Disk icon. When you are asked if you want to copy over the file called ProDOS, click No.
Important

There is already a copy of ProDOS on the System Disk and it's probably a more recent version of ProDOS than the version on your AppleWorks disk. You need ProDOS version 1.2 or later to be able to print to a network printer.

4. Give AppleWorks information about your network printer:

- Use the Program Launcher to open the application called APLWORKS.SYSTEM.
- Choose Other Activities from the Main Menu.
- Choose Specify information about your printer(s).
- Choose Add a printer.
- Choose Apple Imagewriter (even if you'll be printing with a LaserWriter).
- Type the name of one of your network printers.
- Choose slot 7.

Now that you've copied AppleWorks to your System Disk and configured AppleWorks for use with a network printer, you never have to go through those steps again. From now on, all you have to do is start up your copy of the System Disk that has AppleWorks on it, use the Chooser to pick the printer you specified when you gave AppleWorks information about your printer, then startup AppleWorks.

- Note: The LaserWriter gives you a choice of fonts. The default is Courier. To change to Times-Roman, choose Proportional 1 or 2 in the AppleWorks Option menu.

- Preparing other applications for network printing: Different applications have different ways of asking for information about your printer. If the application asks for the slot number of your network printer, answer slot 7.
THE APPLE PUBLISHING SYSTEM

This Apple manual was written, edited, and composed on a desktop publishing system using the Apple Macintosh™ Plus and Microsoft® Word. Proof and final pages were created on the Apple LaserWriter® Plus. POSTSCRIPT™, the LaserWriter's page-description language, was developed by Adobe Systems Incorporated.

Text type is ITC Garamond® (a downloadable font distributed by Adobe Systems). Display type is ITC Avant Garde Gothic®. Bullets are ITC Zapf Dingbats®. Program listings are set in Apple Courier, a monospaced font.